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How to get MapFileBrowser

MapFileBrowser is free for commercial use. MapFileBrowser can be downloaded for Software Verify's
website at https//www.softwareverify.com/product/map-file-browser/.

This help manual is available in Compiled HTML Help (Windows Help files), PDF, and online.

Windows Help https://www.softwareverify.com/documentation/chm/mapFileBrowser.chm
PDF https://www.softwareverify.com/documentation/pdfs/mapFileBrowser. pdf
Online https://www.softwareverify.com/documentation/html/mapFileBrowser/index.html

Whilst MapFileBrowser is free for commercial use, MapFileBrowser is copyrighted software and is not in
the public domain.

You are free to use the software at your own risk.

You are not allowed to distribute the software in any form, or to sell the software, or to host the software
on a website.

Contact Software Verify at:

Software Verify Limited
Suffolk Business Park
Eldo House

Kempson Way

Bury Saint Edmunds
IP32 7AR

United Kingdom

email sales@softwareverify.com

web https://www.softwareverify.com

blog https://www.softwareverify.com/blog
twitter  http://twitter.com/softwareverify

Visit our blog to read our articles on debugging techniques and tools.
Follow us on twitter to keep track of the latest software tools and updates.
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2 What does MapFileBrowser do?

MapFileBrowser allows you to inspect the contents of a linker MAP file.
You can sort the data, filter the data by name.

You can also query the data by address which can be useful for identifying what function is at a given
address if all you hawve is a crash address and nothing else.

Query by address is supported three ways:
e Query by absolute address.

e Query by address offset from a DLL load address.
e Query by address offset from a symbol.

32 bit and 64 bit

MAP files created by 32 bit and 64 bit software are supported. On 64 bit Operating systems if a 64 bit
MAP file is opened the 64 bit version MAP File Browser is automatically started.

History

MapFileBrowser has been an internal tool at Software Verify for many years. We recently decided to
make it a bit more user friendly and to make it available for public use.
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3 What is a module?

A module is a contained block of executable code and data. For example, a DLL or EXE.
Some software vendors name their DLLs with different file extensions, for example .BPL, .ARX

When you call LoadLibrary to load a module, you are returned a HMODULE, which is an opaque handle
to a module. The HMODULE is most often the same as the module load address, but not always.

The lower few bits of the HMODULE can get OR'd with some flags to create a HMODULE value that is
not the same as the module load address.

You can get the load address of a module from it's HMODULE by masking out the lower 16 bits of the
HMODULE value then casting to a DWORD_PTR.

In this documentation when you read EXE or DLL or module, we are effectively referring to the same
thing. It's easier to read and write "DLLs" rather than "DLLs or EXE".
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4 MAP File contents

MapFileBrowser can read MAP files generated by Microsoft Visual Studio, Delphi, C++ Builder and

various other MAP files.

Some MAP files contain line numbers, some don't. The options for adding line numbers to MAP files
have changed with different versions of compilers and linkers.

Even if a MAP file doesn't contain line numbers, the MAP can still be useful in guiding you to the correct

function that is related to an address.

Visual Studio 6

Visual Studio 6 will add line numbers to your MAP file if you add the following option to your linker

settings /MAPINFO:LINES

Droie attine

Settings For: |'win32 Debug Non Link

Bl

BREE nativeE sample

General | Debug | CAC++ I Link. Rezourc: EE
Category: |Del:uug ﬂ Feset

td apfile name: lv Generate mapfile

|Del:uugN onLinkE_0/nativeE sample.map

Debug Info
[v [Debug info
" Microsoft format

" COFF format
{* Both farmats

v Separate bpes

Project Options:

Adef" AnativeE rample. def"! ”
dout ' Debugilaskbalebelissbinbunmmn| e ore'' =
Apdbtype: zepl AMAPIMFO:LIMES o

k. | Cancel

Visual Studio 7 (2002) and later

Visual Studio 7 and later will not add line numbers to your MAP file. The linker option /MAPINFO:LINES

is not supported.

This means you can't create MAP files containing line numbers for anything you build with Visual Studio

7 (2002) or later, or for any 64 bit builds.
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You can still use MapFileBrowser to identify the function which contains a given address.

nativeExample Property Pages

Configuration: | Active(Release)

Commen Properties
~ Configuration Properties
General
Debugging
VC++ Directories
C/C++
eneral
Input
WSLEM
Optimization
Embedded IDL
Advanced
Command Line
Manifest Tool
Rescurces
XML Document Generator
Browse Information
Build Events
Custom Build Step

~ | Platform: |Active(xtd)

Generate Debug Info
Generate Program Database File
Strip Private Symbols

Generate Map File
Map File Name
Map Exports

? =
™~ Configuration Manager...
Yes (/DEBUG)
ARelease10_0_x64/nativeExample.pdb
Yes (/MAF)
ARelease10_0_x64/nativeExample.map
Mo

Debuggable Assembly

Generate Debug Info

The /DEBUG option creates debugging information for the .exe file or DLL.

Delphi

To create MAP files containing line numbers you need to specify that you want a "detailed" MAP file in
the options for your Delphi or C++ Builder project.

Copyright © 2015-2026 Software Verify Limited
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(c] Project Options for CppBuilderTest1.exe (Win32 - Release)

C++ Linker -
I Delphi Compiler I
Compiling

Hints and Warnings
Output - C/C++
Resource Compiler
Turbo Assembler
Build Events
Build Order
Application
Appearance
Manifest
lcons
Services
Forms
Version Info
Debugger
Symbol Tables
Environment Block
Packages
Runtime Packages

Project Properties v

C++ Builder

Linking

Target

Release configuration - Windows 32-bit platform
Debug information [] false
Include remote debug symbols D false

| > Mapfile Detailed
Maximum Stack Size 1048576

> Minimum Stack Size 16384

Output resource string .drc file [] false
Place debug information in separi [_] false
Set extra PE Header flags 0
Set extra PE Header optional flags 0
Set OS Version fields in PE Header 5.0
Set Subsystem Version fields in PE 5.0
Set User Version fields in PE Head: 0.0

Apply... Save..

Cancel Help

To create MAP files containing line numbers you need to specify that you want a "detailed" MAP file in
the options for your Delphi or C++ Builder project.
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G Project Options for CppBuilderTest1.exe (Winb4 - Release)

C++ Linker = Output
Output
Warnings Target
Delphi Compiler Release configuration - Windows 64-bit platform Apply... Save...
Resource Compiler
Turbo Assembler > Base address 0x 00400000
Build Events Heap size, maximum 000100000
Build Order Heap size, minimum 0x00001000
Application Image comment string
Appearance Image description
Manifest Image flags
lcons I Map file type Detailed segment map I
Services Map with mangled names ] false
Forms 0S version 4.0
Version Info Section flags
Debugger Stack size, maximum 0x 00100000
Symbol Tables Stack size, minimum 0x 00002000
Environment Block User version 0.0

Packages
Runtime Packages
Project Properties
General

Getlt Dependencies

Gt Hap

Other Compilers

If you find that MapFileBrowser cannot read your MAP file, please contact us at
support@softwareverify.com, attaching your MAP file to the email.

We will try to add support for your MAP file format as soon as we can.
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14 MAP File Browser Help
5 Menu
The main menu contains five menus, File, Edit, Query, Software Updates and Help.
&% MAP File Browser x64
File Settings Cuery Software Updates Help
51 File
The File menu controls loading of MAP file information, clearing the display and exiting the program.
Load MAP file...
Close
Exit
File menu > Load MAP file... > loads a MAP file and displays it.
File menu » Close * clear all results, unloads the MAP file information.
File menu * Exit * closes MapFileBrowser.
5.2 Settings
The Settings menu controls editing settings.
Edit Settings...
Settings menu » Edit Settings... * displays the settings dialog.
5.3 Query

The Query menu controls searching for symbols.

Find Symbol with Absclute Address...
Find Symbol with DLL Relative Address...

Find Symbol with Symbel Relative Address...
Find Symbol from Event Viewer XML crash leg...

View Map File Information...

Copyright © 2015-2026 Software Verify Limited
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Query menu * Find Symbol with Absolute Address... * Use this option to turn an absolute address
in a process into a symbol, filename and line number.

See Decoding an absolute crash address for more details.

Query menu * Find Symbol with DLL Relative Address... *» use this option to turn a relative address
inside a DLL into a symbol, filename and line number.

See Decoding a relative crash address for more details.

Query menu * Find Symbol with Symbol Relative Address... * use this option to turn a address
that is relative to a symbol inside a DLL into a symbol, filename and line number.

See Decoding a symbol relative crash address for more details.

Query menu * Find Symbol from Event Viewer XML crash log... * use this option to turn an XML
crash log from the Microsoft Event Viewer to a symbol inside a DLL into a symbol, filename and line
number.

See Decoding an Event Viewer XML crash log for more details.

Query menu * View Map File Information... > use this option to view information about the MAP file.

5.4 Software Updates

The Software Updates menu controls how often software updates are downloaded.

If you've been notified of a new software release to Map File Browser or just want to see if there's a new
version, this feature makes it easy to update.

Check for software updates...
Configure software updates...

Set software update directory...

E Software Updates menu * Check for software updates » checks for updates and shows the
software update dialog if any exist

An internet connection is needed to be able to make contact with our servers.

= Before updating the software, close the help manual, and end any active session by closing
target programs.

If no updates are available, you'll just see this message:

Mo active session

Copyright © 2015-2026 Software Verify Limited
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Software Update dialog

If a software update is available for Map File Browser you'll see the software update dialog.

Software update download confirmation =

A software update is available for MapFileBraowser.

Do you wish to install MapFileBrowser ¥2.74?

Yes, Download and Install | Don't download, ask me later Skip this version, don't tell me about it again

Software update

Software update options... |

e Download and install > downloads the update, showing progress

Downloading MapFileBrowser 2.74 )4

Downloading MapFileBrowser 2,74

3832 KE of 15241 KB (25.1%)

Once the update has downloaded, Map File Browser will close, run the installer, and restart.
You can stop the download at any time, if necessary.

e Don't download... * Doesn't download, but you'll be prompted for it again next time you start Map
File Browser

o Skip this version... > Doesn't download the update and doesn't bother you again until there's an
even newer update

o Software update options... *> edit the software update schedule

Problems downloading or installing?

If for whatever reason, automatic download and installation fails to complete:
¢ Download the latest installer manually from the software verify website.

Make some checks for possible scenarios where files may be locked by Map File Browser as follows:
e Ensure Map File Browser and its help manual is also closed
e Ensure any error dialogs from the previous installation are closed

You should now be ready to run the new version.

Copyright © 2015-2026 Software Verify Limited
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Software update schedule

Map File Browser can automatically check to see if a new version of Map File Browser is available for
downloading.

E Software Updates menu * Configure software updates > shows the software update schedule
dialog

The update options are:
e never check for updates
e check daily (the default)
e check weekly

e check monthly

The most recent check for updates is shown at the bottom.

Software update schedule ? >
CutputDebugStringChedker can check for software updates on a regular basis.

" Mever check for updates
(" Chedk for updates every day
* Check for updates once a week

(" Chedk for updates once a month

Muost recent check for updates was performed on 2022-07-23

QK | Cancel

Software update directory

It's important to be able to specify where software updates are downloaded to because of potential
security risks that may arise from allowing the Tmp directory to be executable. For example, to
counteract security threats it's possible that account ownership permissions or antivirus software blocks
program execution directly from the Tvp directory.

The Tvp directory is the default location but if for whatever reason you're not comfortable with that, you
can specify your preferred download directory. This allows you to set permissions for Tmp to deny
execute privileges if you wish.

|E| Software Updates menu * Set software update directory * shows the Software update
download directory dialog

Copyright © 2015-2026 Software Verify Limited
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5.5

Software update download directory ? X
Software updates will be downloaded to the location spedfied below:
C:\Users'stephen\AppDataL ocal {Temp) Browse. ..
Reset

K | Cancel |

An invalid directory will show the path in red and will not be accepted until a valid folder is
entered.

Example reasons for invalid directories include:

e the directory doesn't exist
e the directory doesn't have write privilege (update can't be downloaded)
e the directory doesn't have execute privilege (downloaded update can't be run)

= when modifying the download directory, you should ensure the directory will continue to be valid.
Updates may no longer occur if the download location is later invalidated.

o Reset > reverts the download location to the user's Tvp directory

The default location is c:\users\ [username] \AppData\Local\Temp

Help

The Help menu controls displaying this help document and displaying information about Map File
Browser.

About Map File Browser...
Readrne and Version History...

Help Topics...
Help POF...

Help on softwareverify.com...

Blog...
Library...

Contact customer support...

How do 7.

Help menu * About Map File Browser... * displays information about Map File Browser.

Help menu * Readme and Version History... * displays the readme and version history.
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Help menu * Help Topics... * displays this help file.
Help menu * Help PDF... > displays this help file in PDF format.

Help menu * Help on softwareverify.com... * display the Software Verify documentation web page
where you can view online documentation or download compiled HTML Help and PDF help documents.

Help menu * Blog... * display the Software Verify blog.

Help menu * Library... * display the Software Verify library - our best blog articles grouped by related
topics.

Help menu *» Contact customer support... > displays the options for contacting customer support.

Contact Software Verify Customer Support *
We provide customer support via email.

Email allows us to exchange detailed bug descriptions, detailed instructions, screenshots, log
files, crash dumps and other metadata that can't easily be communicated via telephone ar chat.

Should your support request require escalation to phone, Zoom or remote computer access we
will do that when required.

There are two methods to start a support request:

Email:

support@softwareverify.com

Website customer support form:
https: /fwww  softwareverify, com/suppart.php

Close

Click a link to contact customer support.

Help menu * How do I1?... > displays the options for asking us how to do a particular task.

Copyright © 2015-2026 Software Verify Limited
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How do |7 =

How do I fly to the moon?
How do I make a purple cow?

How do I do XYZ with MapFileBrowser?
We can't help with the first two guestions, but I think we can help with the last question.
We'll give you step by step instructions and/or a video showing you how to do XYZ.

Just send us an email describing what you're trying to do and we'll get right back to you with a
solution.

Start a Support Reguest

Emiail:

support@softwareverify.com

Website customer support form:
https: /fwww . softwareverify. com/suppart/

Close

Copyright © 2015-2026 Software Verify Limited






22

MAP File Browser Help

6

The user interface

The MapFileBrowser user interface is shown below.

B M e a7 \ - iveErampk 1 _ 5] w
File Seftings Ouery Hep

bapfie E Z inkB_D\nalh ann-l Filtes

] Name (634) |Segment | Section | Address [size  [Type [ Filename Line |~
0 public; _thiscall P ox0001 et D OOQAOAD 64 Publc - ple TESTSVW.CPP ar
n public: _thiscall heapMeaBaseClacs: hespHewBaseClass(void) OwD001 et 00801040 64 Pubkic E 2 les' nativels B lasz.cpp n
R public: _thiscall std::_Tree<unsigned long, struct std:pasr<unsigned long const unsigned lo.. | (x0001 et O 00429960 96 Publc CAProgram Files (x36)\Microsoft Visual Studio\WCI8UNCLUDE xtree 2
i B 00001 e 000424700 9 Public E\omic\rmemeny AP sviDatsTiacker.cpp 7
lic: _thiscall wt %) (D001 et OwD0L24 760 96 Publc E\omi cumemony 32PN sviDataTracker.cpp i3
_thiscall testClass 1=testClass 1 {unsigned long) w0001 et Oe00402480 64 Public E oy 32 gl \ h E
ic: _thiscall testClass2-testClass2{unsigned short) 00001 et Ox00S02ACD 96 Public i o h 2
jc: _thiscalltestClass3-testChass3lvoic) 0x0001 et DeDO402820 64 Public [ lestnativeExampiel nativeExample.h 54
lic: _thiscall testCl e 00001 ext OwD0802120 192 Public i i CPP 9
® public: _thiscall testClass ToBeThrowr-testClassToBaThrownivoid) 0x0001 e 000402080 128 Puble : Exampiel nativeE oy "2
0 private: _thiscall type_infoctype._inf(cless type. info canst &) (001 et 00426650 &4 Public ti_inst.cpp 17|
@ public: __thiscall std::_Tree<unsigned long, struct stc::pair<unsigned long const unsigned lo... | (x0001 et Ou00427D80 480 Publc C:\Program Files (361 Microsoft Visual Studic\ ¥ CORINCLUDE tree 1
a public: _thiscall ATL=CComBSTR: » CComBSTR{veid) OwcD001 et 00421820 48 Pubkic C\Program Files (x86]\Microsoft Visual Studic\WCS8\ATLINCLUDE \atlba 543
a8 public: _thiscall ATL:CComVariant: ~CComVanant(void) 00001 et 00421820 64 Publc CAProgram Files (x36)\Macrosoft Visual Studio\VCIEVATLUNCLUDE atiba. a7
“ public: virtual _thiscall CMainFrame:: ~ CMainFramedvosd) Ouc0001 bext Ow00801880 36 Public E 2\ ! ivebs PP 56| v
Live Mysbere: Flerame. Ehomelmemon3aFeDataTiscker cop L 17
Function: public: __thiscall sviD stal tackessviD staTracker|char const *)
17 Gx0042AT00 fkdes DOMZAT0 By
18 CDOA2ATOE 9 // when this object s deleted the tag tracker will be automatically popped from the stack of tag trackers. A
10 // The top most tag tracker is used to tag allocations.
19 (xD42ATIA 11 JoPARAMETERS. ... cccastaacnassaastasnas
12 trackervame -in-

13 //.RETURN.CODES. . ... ..
14 /4

15

16 svlpacatracker::svlpatatracker {const char °(rackeruamei
mvPus| rackername);

19 ¥

r .

:svipatatracker

DESCRIFTION. L oo v seeseeseneseeseaneens

24 // creates a svlpataTracker object and pushes a tag tracker omto the stack of tag trackers.

25 /¢ when this object is deleted the tag tracker will be automatically popped from the stack of tag trackers. v
. o bl e W L

The user interface consists of a main grid showing functions in the MAP file.

Below is a display for line numbers and a source code display for viewing the source code of any function
or variable that is selected.

Selecting any item in the grid populates the line numbers and source code display as appropriate.

Querying any value will select the nearest item in the main grid and populate the other displays as
appropriate.

Some basic filtering functionality is also provided.

MAP File Information

F] Narme (634) |segment |Section |Address [size [ Type |Filename. e
3 public: _thiscall i w0001 Aot 00204040 &4 Public E 4! i TESTSVW.CPP a7
5n public: _thiscall heaphewBaseClass=hespMewBaseClassivoid] 000 dext 000401040 64 Public lesscpp 7
2 publc: _thiscall sel: 3 5. ir<unsigned leng eonst unsigred le... 0:0001 et 000429960 56 Public €ABragram Files (x861\Micsosoft Visual Studic\ VESEUNCLUDE tree 12
| o5 _thi ) 00001 et 000424700 96 Public Elomicimemony 3 APNsviDataTracker.cpp 7
34 public: _thiscall svlDataTiacken:sviDataTracker{unsigned short const ) 00001 dext OuD0L24TE0 86 Public Ed\omicimemony 32\ AP sviDataTracker.cpp 33
35 pubbe: _thiscall testClass]:testClass 1 (ursigned long) 00001 EL 000802480 B4 Public 30
36 pubbc _thiscall testClass2:testClass2(unsigned short] 00007 et Qe0002ACD 96 Public E\omic a2
Erg publicc _thiscall testClass3:testClass3(void) 0001 dext DD0S02820 &4 Public E\omi, i i h 54
38 pubbic: _thiscall testC| 1 testCl 1 G001 et 00402120 182 Public E i i L 148
E publc: _thiscal testClass tass 0001 et 00402040 128 Public P plech? 142
% private: _thiscall type_infostype.infolctass type_infa const &) 00001 et QOMIESHD &4 Public tiimitcpp ”
41 public: _thiscall std:_Tree<unsigned bong, struct std::pair< unsigned long const ,unsigned lo... (%0001 Aot Oe00427080 480 Public C\Pragram Files (xB6)\Microsoft Visual Studic\ VCSEUNCLUDE xtree 174
42 public: _thiscall A1 ‘omB3TR: ~C ComBSTR{void) w0001 dext DuD0421820 48 Public C\Program Files (xB6)\Microsoft Visual Studich VCSSATLUNCLUDE atlbe... 3843
43 public: _thiseall ATL:CComVariants - CComVriznt(veid) 00001 et 000421820 64 Public C\Pragram Files (x86\Mberosoft Visual Studie WCOBATLUNCLUDBatlba.. 4175
4 public: virtual _thiscall CMainFrames~ CMainFrame(void) D001 et De00401880 96 Public E\ i M, M.CPP 56|v
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The MAP File information shows you the symbol name, segment number, segment name, symbol
address, symbol size, symbol type, and the flename and line number for the symbol.

You can sort the data by clicking no the column header and clicking again to reverse the direction of the
sort.

If you select any item in the grid the lower grids and source code display are populated with data as
appropriate.

If you right click any item a context is displayed which will allow you to perform a symbol relative query.

|chxampIe.exe:Fri Jul 03 10:09:24 2020 2

Line Numbers

Line #...| Address Offset
530 Ox00404060 0
536 Ow0OA04DTF 3
537 OwDOA04096 5
545 DwD0A04D9C &0
545| (x00404D87 87
548 Ow0O404DED o3
551 TheDOJ04DD0 112

The line numbers section lists each line number, the address of that line and the offset of that line from

the start of the owning function. Note that offsets can be negative as well as positive depending on how
the compiler did it's work.

Source Code

Filename  E:hom\ememeey32'enE xample’,\stublibsubib b Line 530
Function: public: _thiscall svilkataTracker svilataT rackes(char %)
Address RO0A0MDED

Copy
522 sviDataTracker class, only available if using €++, thus handled by a separate ifdef "
523 see help for details on usage
524
525 #ifdef __cplusplus
526
527 class svlpatatracker
528
529 ublic:
531 1
532 HMODULE heod;
233
534 get module, will only succeed if Memory validator launched this app or is injected into this app
535 -
536 hMod = GetModulenandle(INJECTED_DLL);
537 }f (hMod != NULL)
538
539 mv is present, lookup the function and call it to push a new tracker onto the tracker stack for this thread

The source code section displays the source code, highlights the selected line and displays information
relating to filename, line number, function and address.

Filters

Wame Filter: | TestClazzMewHeap Filter

Copyright © 2015-2026 Software Verify Limited
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The filters section allows you to filter data by symbol name.

Name Filter

Filtering by symbol name allows you to easily find a particular symbol. This is very useful when wanting
to decode a crash address that has been provided as relative to a symbol (symbol + offset).

Mapfile:  ENomhcmemony 32 example: \nativeE xample\Debugh onLink6_0hnativeE xample. map

Mame Ftee. [TeoClassiontiess  Filer
¥ Mame (4) Segment |Section | Address [size  [Type [Filename
1 public: _thiscall TestClassMNewHeap: TestClassMewHeap(void) Qw0001 Aext Oc0040A240 95 Public Ef\om\c\memary32\ examplesinativeExample\ TESTSVW.CPP
2 public: virtual _ thiscall TestClassNewHeap:: ~ TestClassMewHeapivoid) 0001 text 00202520 95 Public E\om\cimemory32\ examples\nativeExample\ TESTSVW.CPP
3 public: void _ihiscall TestClasshewteap:setDatal {unsigned long) 0001 text 00400920 64 Pubhic Efvomicimemany 32\ examplesinativeExample TESTSVW.CPP
4 public: voed _thiscall TestClaseNewHeap::cetDatal (unsigned long) 00001 Aext Ow0040D250 &4 Pubbc

Efem\c\memony 32 examplesinativeEs ample) TESTSVW.CPP
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71

Settings dialog

The settings dialog allows you to control the behaviour of Map File Browser.

There are three main sections: Symbols, Data display and source code paths.

Settings

Su_attings

: Data Display
i Source Paths
L. Path Substitutions

Symbols
% Display symbals as human readable names

™ Display symbols as compiler decorated names

Reszet All Reset Help (F1) oK | Cancel

Symbols

The Symbols settings allow you to choose how symbols are displayed.
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Settings ? *
Su:athngs Symbols
Data Display i+ Display symbals as human readable names
i~ Source Paths
. Path Substitutions (" Display symbals as compiler decorated names

Reset All Reset Help (F1) oK | Cancel

Depending upon the task you are performing you may wish to read the symbols as human readable
symbols or compiler decorated C++ symbols.

Reset - Resets the settings on the current page.

Reset All - Resets all global settings, not just those on the current page.

7.2 Data display

The Symbols settings allow you to choose how symbols are displayed.
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7.3

Settings ‘ :
s?thngs Data Display
i~ Symbaols
g Data Display {*" Ifline numbers in MAP file use these filters

i Source Paths

- Path Substitutions | Display Imported Functions

| Display Compiler Generated Code
I Display Linked Code

I Display Functions that have no size

" If no line numbers in MAP file show all functions

Reset All Reset Help (F1) oK | Cancel

For MAP files that have line numbers you may wish to view additional information as well as the line
numbers.

¢ If line numbers in MAP file > display all information relating to symbols that have line information

O

Display Imported Functions » functions imported from other DLLs will be displayed

o

Display Compiler Generated Code > compiler generated code will be displayed

o

Display Linked Code * linked object code from .obj and .lib will be displayed

o

Display Functions that have no size > symbols with no size will be displayed

¢ If no line numbers in MAP file * display all information that was found in the MAP file

Reset - Resets the settings on the current page.

Reset All - Resets all global settings, not just those on the current page.

Source code paths

The Source code paths settings allow you to specify where Map File Browsers looks for source code
files.

Copyright © 2015-2026 Software Verify Limited



Settings dialog 29

Settings ! x
S:eth'ngs Source Search Paths
Symbaols
i Data Display
path |
EvombcibuildMumber Remave

‘... Path Substitutions

i3

Remaove All

Set Default

ResctAl |  Reset Help (F1) ok | Cancel |

|

Manually adding path type directories

The Path list shows all the paths that will be searched for debug information in PDB files.

You can modify the list of files for each path type in the following ways:
e Add » appends a row to the directory list * enter the directory path

Edit a directory path by double clicking the entry. The usual controls apply for removing list items:
e« Remove * remowes selected items from the list

o Remove All * clears the list

o Set Default * populates the list with each directory found in the PATH environment variable
Alternatively, press to delete selected items, and Ctri to select all items in the list first.

Reset - Resets the settings on the current page.

Reset All - Resets all global settings, not just those on the current page.
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7.4

Path Substitutions

The Path Substitutions tab allows you to specify file path substitutions to handle copying builds from
build machines to development or test machines .

The default settings are shown below:

-
x

Settings

Settings Path Substitutions

- Data Display
i Source Paths

¥ path Substitutions

New Path  Old Path Ad

Gh\devibuild ehdevibuild Remove

Remaove All

Bl

Reset All Reset Help (F1) oK I Cancel

Path Substitutions

Some software development schemes have multiple rolling builds of their software, often enabled by
using substituted disk drive naming schemes.

When you download the build to your development machine for development and testing, debugging
information may reference disk drives that don't exist on your machine, for example, drive X while your
machine only has C:, D:, and E: drives.

Or you may just be copying a build from a drive on a development machine to a subdirectory on a drive
on your test machine.

These options let you remap the substitution so that the MAP File Browser looks in the correct place for
the source code.

e Add » adds a row to the File Paths Substitutions table * enter the new path that will replace the
old path in the New Path column ¥ click in the Old Path column * enter the path that is being

replaced
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For example, you might enter c:\users\stephen\documents for the new path and £:\dev\build
for the old path.

You can double click to edit drives and paths in the table, or remowe items:
o Remove * removes selected substitutions from the list

o Remove All ¥ remowes all substitutions from the list

Alternatively, press m to delete selected items, and + to select all items in the list first.

Example: Changed disk drive

Project originally located at m:\dewbuild\testApp

Project copied to e:\dewbuild\testApp

New Path e\

Old Path m:\

Example: Project copied to a new location

Project originally located at f\devbuild\testApp

Project copied to C:\Users\Stephen\Documents\testApp
New Path C:\Users\Stephen\Documents

Old Path f\dewbuild

E| The slashes do not have to match, a forward slash will match a backslash when comparing path
fragments. This is deliberate - to improve ease of use with libraries built by different compilers (LLVM and
compilers that use it use forward slashes, whereas Visual Studio etc use backslashes).

Reset All - Resets all global settings, not just those on the current page.

Reset - Resets the settings on the current page.
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8 MAP File Information

The MAP File Information dialog displays information about a MAP file that is not displayed by the main
display.

This information includes the DLL/EXE name, timestamp, preferred load address, entry point and a list of
the segments that make up the binary image.

Map File Information >
Object File: nativeExample
Timestamp: 61811c2d (Tue Nov 02 11:08:29 2021)
Preferred Load Address: 000400000

Entry Point: 0x0001:0x000163A0

Segments:
Segment (21) | Section Address Length | Class ~
1 text (00071060 00000000 04994 CODE
2 dextix Cx00071:0:000173.20 5565 CODE
3 Jddata’s Cr0002: 0 00000000 2024 DATA
4 .rdata (e 0002: 05 O0000TES G544 DATA
5 rdatabr (¢ 0002: 06000002030 63| DATA
& xdatasx O 0002: 0600002072 7032 DATA
7 Jddatasd Cr0002: 0 00004928 320 DATA
8 JAdatas3 (e 0002: 060 00004 A68 20| DATA,
g JAdatald (000206 00004 7TC 2024 | DATA v
< >

Close
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9 How to use MapFileBrowser

Load MAP File Information
Use the File > Load MAP file... option to load the appropriate MAP file.

The grid displays various attributes of each symbol in the MAP file. You can sort the grid by clicking the
appropriate column header. Click the same header to reverse the sort order.

Select a symbol to see information about the line numbers and source code.

Filtering

You can filter by name by typing the name into the Name Filter box and clicking the Filter button to
perform the filtering.

Viewing function data

As each item in the list is selected the Line Numbers are updated and the source code display updates
to show the source code for the function. All lines in the function that contain executable code (as
indicated by the line number information) are coloured grey. The current line for the function is coloured
bright green.

Querying data

You can query data by using the two Query fields below the main grid.

Relative query

Type the relative address (also know as address offset) into the Query by Offset field, then click Query.
The symbol information is displayed.

The field accepts decimal or hexadecimcal values. Hex values must be prefixed with Ox.

Absolute query

Type the absolute address into the Query by Address field, type the absolute DLL load address into the
Alternate Load Address field, then click Query. The symbol information is displayed.

The fields accept decimal or hexadecimcal values. Hex values must be prefixed with Ox.
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9.1

Decoding an absolute crash address

Scenario:

A customer has supplied you with a crash report containing a callstack with addresses. The callstack
also indicates which module relates to which address.

The customer has also supplied you with a list of module load addresses.

Example Data:
Exception code: C0000005 ACCESS VIOLATION

Fault address: 0x005f5eec (base 0x00400000) C:\Program Files (x86)\Software Verification)\

Exception Parameters:
0: 0x00000000 [Read Error]
1: 0x035f0034 [Address]

Registers:
EAX:035F0034
EBX:00000000
ECX:FFFDDO0O0O
EDX:00002370
ESI:006F7D58
EDI:035F0034
CS:EIP:0023:005F5EEC
SS:ESP:002B:0018FE14 EBP:0018FE3C
DS:002B ES:002B FS:0053 GS:002B
Flags:00010202

StackTrace

C:\Program Files (x86)\Software Verification\C++ Memory Validator\memoryValidator.exe
C:\Program Files (x86)\Software Verification\C++ Memory Validator\memoryValidator.exe
C:\Windows\syswow64\msvcrt.dll : 0x75D70000 : 0x75D7C3E4
C:\Windows\syswow64\msvcrt.dll : O0x75D70000 : 0x75D836B6

C:\Program Files (x86)\Software Verification\C++ Memory Validator\memoryValidator.exe
C:\Windows\syswow64\kernel32.d1ll : 0x754D0000 : O0x754E3365
C:\Windows\SysWOW64\ntdll.d1ll : 0x77920000 : 0x77959F6D

C:\Windows\SysWOW64\ntdll.d1ll : 0x77920000 : O0x77959F40

C:\Windows\SysWOW64\ntdl1l.d1ll : 0x77920000 : 0x77959F40

This is data from a real crash a few years ago, from C++ Memory Validator 5.80.

Question:
How do you decode these absolute addresses?

Answer:
In the above data we can see a callstack containing entries for ntdll.dll, msvecrt.dll, and
memoryValidator.exe.

All the modules are Microsoft DLLs except for the EXE, which is part of C++ Memory Validator, one of
our tools.

To decode these values, we load memoryValidator.map into MapFileBrowser, then for each symbol we
take the following actions.

For our purposes here, we're going to show how to convert one symbol. We're going to use the first
symbol from memoryValidator.exe in the example data above.
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0x005f5eec (base 0x00400000)

The address is 0x005f5eec. The DLL loaded at 0x00400000. You'll notice the load address for all
MemoryValidator.exe entries is 0x00400000.

From the Query menu choose Find Symbol with Absolute Address....

Find Symbol with Absclute Address...
Find Symbol with DLL Relative Address...
Find Symboel with Symbel Relative Address...

Find Symbol from Event Viewer XML crash leqg...

View Map File Information...

The Query Symbol by Absolute Address dialog is displayed.

Cuery Symbol by Absolute Address ? X

DLL: mvExample

DLL Load Address: |

What's a load address?

Address: |

Find Symbal | Cancel

Type the DLL load address into the DLL Load Address field. Prefix any hexadecimal addresses with Ox.
Type the symbol address into the Address field. Prefix any hexadecimal addresses with 0Ox.

Click the Find Symbol button.

Cuery Symbaol by Absolute Address ? *

DLL: mvExample

DLL Load Address: | MEWENNNY

What's a load address?

Address: | 0x005f5eec

Find Symbaol | Cancel

The appropriate location in the code is found and displayed.
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9.2

Filename:  E:\ombcimemar32itabzen\MemanSettingData.cpp Line 5365

Function: private: int __thiscall MemorySettingD ata: saveSoftwareUpdatelnformation{struct HKEY__ = canst |

Address:  Ox00SFEEEC Copy
5358 f/—NA ~
5359

5360

5361

5362

5363

5364

5366 int DE = TRUE;

5367

5368 ok & writeData(hKey, _T("suea"), softwareUpdateEmailAddress); // stephen@softwareverify.com

5369 ok &= writeData(hKey, _T("sup"), softwareUpdatePassword); // tester

5370 ok &= writeData(hKey, _T("sus"), (DWORD &)softwareUpdateSchedule);

5371 ok & writeData(hKey, _T("sulc"), softwareUpdatelLastCheck);

5372

5373 . return ok; v
< >
Results:

Repeating the process for the data shown abowe resulted in this information.

0x005f5eec (base 0x00400000) C:\Program Files (x86)\Software Verification\C++ Memory Valid

:\Windows\syswow64\msvcrt.dll : 0x75D70000 : O0x75D7C3E4
:\Windows\syswow64\msvcrt.dll : 0x75D70000 : 0x75D836B6

:\Windows\syswow64\kernel32.d1ll : 0x754D0000 : O0x754E3365
:\Windows\SysWOW64\ntdll.d1ll : 0x77920000 : 0x77959F6D
:\Windows\SysWOW64\ntdll.dll : 0x77920000 : 0Ox77959F40
:\Windows\SysWOW64\ntdll.dll : 0x77920000 : O0x77959F40

OO OO OO ONE]

Help! | have a crash address but | don't know what the load address is? What do | do?

You need to read about load addresses.
Decoding a relative crash address
Scenario:

A customer has supplied you with a crash report containing a callstack with relative offsets from DLLs.
The callstack also indicates which module relates to which address.

Example Data:

:\Program Files (x86)\Software Verification\C++ Memory Validator\memoryValidator.exe
:\Program Files (x86)\Software Verification\C++ Memory Validator\memoryValidator.exe

:\Program Files (x86)\Software Verification\C++ Memory Validator\memoryValidator.exe
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Exception code: C0000005 ACCESS VIOLATION
Fault offset: 0x00036FA3 C:\WINDOWS\system32\MSVCRT.dl1l
Exception Parameters:

0: 0x00000000 [Read Error]

1: 0x5f8£f2000 [Address]

Registers:
EAX:B3BEB6D4
EBX:5F8CB6CS8
ECX:150BE5SBS
EDX:00000000
ESI:5F8F2000
EDI:01B98DEC
CS:EIP:001B:77C46FA3
SS:ESP:0023:0012F158 EBP:0012F160
DS:0023 ES:0023 FS:003B GS:0000
Flags:00010212

StackTrace

:\WINDOWS\system32\MFC42u.DLL : 0x0000270a

:\Program Files\Software Verification\Memory Validator\memoryValidator.exe : 0x000db989
:\Program Files\Software Verification\Memory Validator\memoryValidator.exe : 0x000dblf8
:\Program Files\Software Verification\Memory Validator\memoryValidator.exe : 0x00121a83
:\Program Files\Software Verification\Memory Validator\memoryValidator.exe : 0x00121b7e
:\Program Files\Software Verification\Memory Validator\memoryValidator.exe : 0x00174ec5

:\Program Files\Software Verification\Memory Validator\memoryValidator.exe : 0x00175094
:\WINDOWS\system32\MFC42u.DLL : 0x00013724
:\WINDOWS\system32\MFC42u.DLL : 0x00014245
:\WINDOWS\system32\MFC42u.DLL : 0x00001b31
:\WINDOWS\system32\MFC42u.DLL : 0x0008cba’

OO ONONONONONONONOINe]

This is data from a real crash many years ago.

Question:

There are no DLL load addresses and the addresses aren't addresses, but offsets from the start of a
DLL. How do you decode these relative offsets?

Answer:
In the above data we can see a callstack containing entries for mfc42u.dll, and memoryValidator.exe.

All the modules are Microsoft DLLs except for the EXE, which is part of C++ Memory Validator, one of
our tools.

To decode these values, we load memoryValidator.exe into MapFileBrowser.exe, then for each symbol
we take the following actions.

For our purposes here, we're going to show how to convert one symbol. We're going to use the first
symbol from memoryValidator.exe in the example data above.

C:\Program Files\Software Verification\Memory Validator\memoryValidator.exe : 0x000db989

The relative address (or offset) is 0x000db989. We don't know the DLL load address.

From the Query menu choose Find Symbol with DLL Relative Address....
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Find Symbol with Absolute Address...
Find Symbol with DLL Relative Address...
Find Symbol with Syrmbol Relative Address...

Find Symbol from Event Viewer XML crash leqg...

View Map File Information...

The Query Symbol by Absolute Address dialog is displayed.

CQuery Symbol by Relative Offset ? >

DLL: mvExample

Offset:

| Find Symbaol I Cancel

Type the relative address into the Offset field. Prefix any hexadecimal addresses with Ox.

Click the Find Symbol button.

Query Symbal by Relative Offset ? *

DLL:  mwvExample

Offset: |

| Find Symbal I Cancel |

The appropriate location in the code is found and displayed. In this example MapFileBrowser could not
locate the source code (as the file location is not valid on this machine)

Filename: E:\om\chcoveragel alidator.commontstackStuff.epp Line 738

Function: void __cdec! doStack TraceStinglunsigned shart * *unsigned long.unsigned longunsigned long.unsigned shart * *.int.intint struct _COMTEXT *int.int)

Sodiess 0x1003486F e

1 Unable to open file:E:\om\c\coverageValidator‘\common\stackStuff.cpp ~
Results:
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Repeating the process for the data shown abowe resulted in this information.

Exception code: C0000005 ACCESS VIOLATION
Fault offset: 0x00036FA3 C:\WINDOWS\system32\MSVCRT.dl1l
Exception Parameters:

0: 0x00000000 [Read Error]

1: 0x5f8£f2000 [Address]
Registers:

EAX:B3BEB6D4

EBX:5F8CB6C8

ECX:150BE5BS

EDX:00000000

ESI:5F8F2000

EDI:01B98DEC

CS:EIP:001B:77C46FA3

SS:ESP:0023:0012F158 EBP:0012F160

DS:0023 ES:0023 FS:003B GS:0000

Flags:00010212
StackTrace
C:\WINDOWS\system32\MFC42u.DLL 0x0000270a
C:\Program Files\Software Verification\Memory Validator\memoryValidator.exe 0x000db989
C:\Program Files\Software Verification\Memory Validator\memoryValidator.exe 0x000db1f8
C:\Program Files\Software Verification\Memory Validator\memoryValidator.exe 0x00121a83
C:\Program Files\Software Verification\Memory Validator\memoryValidator.exe 0x00121b7e
C:\Program Files\Software Verification\Memory Validator\memoryValidator.exe 0x00174ec5
C:\Program Files\Software Verification\Memory Validator\memoryValidator.exe 0x00175094
C:\WINDOWS\system32\MFC42u.DLL 0x00013724
C:\WINDOWS\system32\MFC42u.DLL 0x00014245
C:\WINDOWS\system32\MFC42u.DLL 0x00001b31
C:\WINDOWS\system32\MFC42u.DLL 0x0008cba7’

9.3 Decoding a symbol relative crash address

Scenario:

A customer has supplied you with a crash report containing a callstack with symbol relative offsets from

DLLs. The callstack also indicates which module relates to which address.

Example Data:
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ntoskrnl.exe!KeSynchronizeExecution+0x2246
ntoskrnl.exe!KeWaitForMultipleObjects+0x135e
ntoskrnl.exe!KeWaitForMultipleObjects+0xdd9
ntoskrnl.exe!KeWaitForSingleObject+0x373
ntoskrnl.exe!KeStallWhileFrozen+0x1977

ntoskrnl.exe! misaligned access+0x13f9
ntoskrnl.exe!KeWaitForMultipleObjects+0x152f
ntoskrnl.exe!KeWaitForMultipleObjects+0xdd9
ntoskrnl.exe!KeWaitForSingleObject+0x373
ntoskrnl.exe!NtWaitForSingleObject+0xb2

ntoskrnl.exe!setjmpex+0x34a3

ntdll.dll!ZwWaitForSingleObject+0xa
KERNELBASE.dll!WaitForSingleObjectEx+0x98
svlcoveragevalidatorstub.dll!sendCommandLineAndStartTimeToGUI+0x2868
svlcoveragevalidatorstub.dll!setValidatorFeedbackHookingComplete+0xlfa6
svlcoveragevalidatorstub.dll!svl sendMessageRawToUserInterface+0x21837
svlcoveragevalidatorstub.dll!svl sendMessageRawToUserInterface+0x218cb
KERNEL32.DLL!BaseThreadInitThunk+0x22
ntdll.dl1l!RtlUserThreadStart+0x34

This is real data from a bug at Software Verify Ltd. This is one thread from many in a dump relating to a
deadlock bug we were investigating.

Question:
How do you decode these symbol relative offsets?

Answer:
In the above data we can see a callstack containing entries for ntoskrnl.exe, ntdll.dll, kernelbase.dll,
kernel32.dIl and svcowveragevalidatorstub.dll.

All the modules are Microsoft DLLs except for one DLL, which is part of C++ Cowverage Validator, one of
our tools.

To decode these values, we load svMCoverageValidatorStub.dll into MapFileBrowser, then for each
symbol we take the following actions.

For our purposes here, we're going to show how to convert one symbol. We're going to use the first
symbol from svCowerageValidatorStub.dll in the example data above.

svlcoveragevalidatorstub.dll!sendCommandLineAndStartTimeToGUI+0x2868

Type the symbol name into the Name Filter field, then click Filter. This makes it easy to find the
symbol we want.

pvExample.exe (Running)

Once we have found the symbol, right click on the symbol to display the context menu and choose
Offset from this symbol....

cvExample.exe:Fri Jul 03 10:0%:24 2020

An alternate method is to click on the symbol to select it, then from the Query menu choose Find
Symbol with Symbol Relative Address....
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Or, from the Query menu choose Find Symbol with Symbol Relative Address... then choose the
symbol you want from the combo box.

Find Symbol with Absolute Address...
Find Symbol with DLL Relative Address...
Find Symbol with Syrmbol Relative Address...

Find Symbol from Event Viewer XML crash leqg...

View Map File Information...

Type the offset into the dialog (hex values must be prefixed with 0x) and click OK.

Cuery Symbol by Symbol Offset ? >

Ee (< - i CommandLine AndStar tTimeToGUT

Offset: | 0x00002868

HndSymbcII Cancel

The appropriate location in the code is found and displayed.

Filenarne: E:“ombchooverageV alidatarcommon’stackStuff.cpp Line 736

Function: void __cdec! doStack TraceSting(unsigned short * * unsigned long,unsigned long,unsigned long,unsigned shart * * int int.int struct _COMTEXT * int int]

Address:  Ox1003426F Copy

1

Unable to open file:E:‘\om\c\coveragevalidator'commonstackstuff.cpp

Results:

Repeating the process for the data shown abowve resulted in this information.

svlcoveragevalidatorstub.dll!sendCommandLineAndStartTimeToGUI+0x2868
svlcoveragevalidatorstub.dll!setValidatorFeedbackHookingComplete+0x1fab
svlcoveragevalidatorstub.dll!svl sendMessageRawToUserInterface+0x21837
svlcoveragevalidatorstub.dll!svl sendMessageRawToUserInterface+0x218cb

94 Decoding an Event Viewer XML crash log

Scenario:
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A customer has supplied you with data from Windows Event Viewer about a crash. The log contains XML
and you don't know which values are relevant.

The event log data will have a provider name of "Windows Error Reporting" or "Application Error".
The XML data is found on the "Details" tab with the XML View radio box selected.

Example Data:
<Event xmlns="http://schemas.microsoft.com/win/2004/08/events/event">
<System>
<Provider Name="Application Error" />
<EventID Qualifiers="0">1000</EventID>
<Level>2</Level>
<Task>100</Task>
<Keywords>0x80000000000000</Keywords>
<TimeCreated SystemTime="2020-02-11T10:42:39.000000000Zz" />
<EventRecordID>260330</EventRecordID>
<Channel>Application</Channel>
<Computer>hydra</Computer>
<Security />
</System>
<EventData>
<Data>testDeliberateCrashVS6.exe</Data>
<Data>1.0.0.1</Data>
<Data>5e42850d</Data>
<Data>testDeliberateCrashVS6.exe</Data>
<Data>1.0.0.1</Data>
<Data>5e42850d</Data>
<Data>c0000005</Data>
<Data>00001d07</Data>
<Data>1490</Data>
<Data>01d5e0c7fa70e745</Data>
<Data>E:\om\c\testApps\testDeliberateCrashVSé6\Debug\testDeliberateCrashVS6.exe</Data>
<Data>E:\om\c\testApps\testDeliberateCrashVS6\Debug\testDeliberateCrashVS6.exe</Data>
<Data>390bde30-4cbb-11lea-83d3-001e4£fdb3956</Data>
<Data />
<Data />
</EventData>
</Event>

This is data from a test program that is designed to crash.
Question:
There the event log indicates a DLL, but no load address, two different addresses, an exception code and

an offset from the start of the DLL. How do you decode this relative offset?

Answer:
MapFileBrowser has an option specifically for this occasion.

The XML data indicates the crash happened in testDeliberateCrashVS6.exe. Load this into
MapFileBrowser being sure to load the correct build version and that the PDB file can be found so that
symbols get loaded.

From the Query menu choose Find Symbol from Event Viewer XML crash log....
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Find Symbol with Absolute Address...
Find Symbol with DLL Relative Address...
Find Symbol with Syrmbol Relative Address...

Find Symbol from Event Viewer XML crash loqg...

View Map File Information...

The Query Symbol by Absolute Address dialog is displayed.

45

Event Viewer XML Crash Data

Paste your Event Viewer XML crash data here:

Find Symbal

Cancel

Paste the XML data from the Event Viewer into the text field.

Click the Find Symbol button.
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9.5

Event Viewer XML Crash Data ? X

Paste your Event Viewer XML crash data here:

<Event> ﬁ
<Systems
<Provider Name="Windows Error Reporting”/>
<TimeCreated SystemTime="2021-11-03:10:18:1
</System=
<EventDatas
<Datax</Data>
<Data=</Data>
<Data=APPCRASH</Data>
=Datax</Data>
<Data=</Data>
<Data=E:\om\c\TestAppsitestDeliberateCrashyv
<Datax</Datas
<Data=</Datas
<Data=E:om\c'\TestAppsitestDeliberateCrashyv v

cNatase /Natas
£ >

Find Symbal Cancel

The appropriate location in the code is found and displayed.

Filename: E:‘omhchiestippshtestDeliberateCraszhi'S6\testDeliberateCrazin'S 60 0. cpp Line 178
Function:  private: void __thizcall CTestDeliberateCrashySED D cauzed Crashivaid]
Addresz 0x004023C0

170 ¥

171

172 faid CTestDeliberateCrashvs6Dlg: :0nOK ()
173

174 causeACrash();

175 1

176

177 vold CTestDeliberateCrashvseDlq: :causeACrash()
179 cHar sptr = MULL;

180

181 *ptr = "\O"; [/ crash

182 ¥

183

What is a load address?

A load address is the address at which a DLL loads.

All versions of Microsoft Windows load modules (.dll, .exe) into address space that is reserved using a

call to VirtualAlloc().
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The allocation of VirtualAlloc() can be queried by calling Win32 API GetSystemInfo() and examining the
value returned in dwAllocationGranularity. For all versions of Microsoft Windows this has been 64KB.
Why is the load address important?

The load address is important because without it we can't calculate the offset inside the DLL so that we
can obtain a symbol.

That's why a crash address with no DLL Load Address isn't very useful - we don't know which DLL the
crash is in, nor do we know where the DLL was loaded.
But | don't have a load address. What can | do?

Depending upon how your module (DLL/EXE) was built we may be able to guess the correct load
address.

If the OS you are using is Windows XP or earlier, we can guess the address.

First a brief chat about Address Space Layout Randomisation...

If the OS you are using is Windows Vista or later, we may be able to guess the load address. The
reason this is not precises is because something known as Address Space Layout Randomisation
(ASLR) was introduced with Microsoft Vista to improve security against many malicious computer
attacks. Any program built with ASLR enabled when run on Vista (or later) will have the load address for
all modules (including the .exe) randomised, making guessing the load address a waste of time.

ASLR is enabled by the /[DYNAMICBASE in the linker settings of Visual Studio.

If you are using Visual Studio 2005 or earlier this setting is not available, your program is not affected by
ASLR.

If you are using Visual Studio 2008 or later you will need to check to see if this option is present. If it is
not present, your program is not affected by ASLR.

If you are not using Visual Studio to build your program then you may not be affected by this option,
consult your compiler/linker documentation.

If your program is not affected by ASLR...

We can try to guess the load address of your DLL/EXE. We can do this regardless of which

compiler/linker you used to build your program. All the programs | mention here are free to download at
the time of writing this help file.

VM Validator
https://www.softwareverify.com/cpp-virtual-memory.php

This works for 32 bit and 64 bit programs.
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Method 1
e Start your program using VM Validator or attach to your running program with VM Validator.
¢ On the Summary tab, inspect the DLLs sub tab in the lower half of the display.
e Find the DLL name in the DLL column.

e The load address is the value in the Address column.

Page Faults
DLL (133) Fault Count Address |Size Commit Reserve CPU
E\om\c\dbgHelpBrowser\Release'x86\dbgHelpBrowser.exe (1] 000400000 1176.00 KB 1176.00 KB 0.00 KB x86
E\om\chtestAppsitestDeliberateCrash'\Release\testDeliberateCrash.exe o (00640000 100.00 KB 100.00 KB 0.00 KB | x86
E\om\c\dbgHelpBrowser\Release\x 86\ svIPelnfo.dll o 0x006C0000 172.00 KB 172.00 KB 0.00 KB | %86

Method 2
e Start your program using VM Validator or attach to your running program with VM Validator.
¢ Go to the Paragraphs tab.
¢ Find any purple entry, check the DLL name in the Description field.

e The load address is the value in the Address column.

Summary Virtual Pages
Address Size ‘ Type | Protect Working Set Shared Swap Description
0x002C0000 B4 KB Private Read, Write Read/write. Commited, Reserved
0x002D0000 152 KB Private Reserved, Commited, Reserved
000300000 1,024 KB Private Reserved
000400000 1176 KB Image  Read Only Read-only. Executable and read-only.  Shared: 98 elom\c el 86\dbghelp exe
0x00530000 796 KB Mapped Read Only Read-only. Shared: 49 Commited, Free

In the example abowe, for dbgHelpBrowser.exe, the load address is 0x00400000.
Process Explorer
https://technet.microsoft.com/en-us/sysinternals/processexplorer.aspx
This works for 32 bit and 64 bit programs.

e Start your program

e Start Process Explorer. If your program is a service or runs as administrator you'll need to start
Process Explorer as administrator.

¢ In Process Explorer, enable View -> Show Lower Pane. Then for View -> Lower Pane Window,
choose DLLs.

e Select your program in the top window.

e Find your DLL in the bottom window. Right click. Choose Properties from the Context menu.
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File Options View Process Find DLL Users Help

(2 Process Explorer - Sysinternals: www.sysinternals.com [ZEUS\Stephen]

FIEIE =T IS e

HEIH

Process CPU  Private Bytes Working Set  PID  Description Comparny Name
@ SecurityHealth Systray exe 1712K 8,704 K 11880 Windows Security notificatio... Microsoft Corporation
@, Onelrive exe 29012K 70728 K 12044 Microsoft OneDrive Microsoft Corporation
CIIWZQKPICK EXE 1496 K 8.108K 6852 WinZip Executable WinZip Computing, Inc
MTnotepad.exe 32K 16.952 K 308 Notepad Microsoft Corporation
2 &sv\launcher.exa 4696 K 12588 K 1052 sviLauncher Software Verify Limited - w...
gHelpBrowser exe 28420 K 51624 K 6840 dbgHelpBrowser
eventlogerashbrowser exe 12.48 5896 K 16,708 K 8836 Event Log Crash Browser Software Verify Limited - w...
vm\Validator exe 614 9664 K 21564 K 6188 vmValidator Software Verify Limited -w...
@HELPMJ\N.B{E 0.23 108,860 K 186,692 K 5396 Help & Manual EC Software GmbH
Name Description Company Name Path
DataExchange dll Data exchange Microsoft Corporation C:\Windows \SysWOW6E4\DataExchange dll
daveint dil Web DAV Client DLL Microsoft Corporation C:\Windows \SysWOWE4 \davelnt.dll
davhlprdi DAV Helper DLL Microsoft Corporation C:\Windows'SysWOWE4 \davhlpr.dll
dbgHelp.dll Windows Image Helper Microsoft Corporation E:'om'\cdbgHelpBrowser\Release'x 86 \dbgHelp dil
dbgHelpBrowser exe dbgHelpBrowser E:‘om‘c'dbgHelpBrowser\Release'x 86 \dbgHelp Browser.exe
deomp dil Microsoft DirectComposition Library ~ Microsoft Corporation C:\Windows\SysWOW6E4\dcomp dll
DevDispltemProvider.dil Deviceltem inproc devguery subsy... Microsoft Corporation C:WWindows \SysWOWE4\DevDisptemProvider.dll
devabj.dll Device Information Set DLL Microsoft Corporation C:\Windows \SysWOWE4 \devobj.dil
dinashext dll DLNA Mamespace DLL Microsoft Corporation C:\Windows \SysWOW6E4 \dinashext dll
drprov dil Microsoft Remote Desktop Sessio...  Microsoft Corporation C:\Windows \SysWOW6E4 \drprov dil

CPU Usage: 33.45% Commit Charge: 28.15% Processes: 193

¢ In the Properties dialog, read the load address.
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4| dbgHelpBrowser.exe Properties — O *
Image  strings
Image
Description:
Company: nfa
Version: 2.41.0.0
Build Time: Sun Jum 21 10:27:39 2020
Path:
| E:Yom'c\dbgHelpBrowser \Release w86 \dbgHelpBrowser, exe | Explore
Autostart Location:
| nfa | Explore
Load Address:  0x0000000000400000 Verify
Mapped Size:  Ox 126000 bytes
Mapping Type: Image
VirusTotal: Submit
Image: 32-bit
Cancel

In the example above, for dbgHelpBrowser.exe, the load address is 0x00400000.

Visual Studio (any version)
https://www.visualstudio.com/

e Start Visual Studio.

¢ From the Project menu, choose File -> Open -> Solution. Choose your executable.

¢ From the Debug menu, choose Start Debugging.

e From the Debug menu, choose Windows -> Modules.
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¢ In the Modules window, find your DLL, then read the Address column.

Madules

Mame

A nedildi
A kemel32.dil
A KemelBase.dil

2 edSuppordil
A mfc] O0udl

A maver100.dil
A user3z.di

A gdazdl

A advapidzdl
) shelizzdil

A alas.a27 a0
<

] Modules

] threadLockgh...

) sviEditT oolAfe...

X
Path Optimized  User Code  Symbol Status Symbal File Or. Vession Timestamg Adldress Process *
E\orr c\threadLockChecker\Rele... Symbols loaded.  EhomicithreadLockChec... 1 18/05/2017 1328 00130000-00204000
CAWindows\SysWOWEntdllall  N/A N/A Symbols loaded .. CA\Usersistepher\AppDat.. 2 630600.8. 10/02/20161%50  T7SADOO0-TTTOFON)
CAWindows\ SysWOWEHkemel32.  W/A NiA Symbols loaded .. CA\UsersistepheriAppDat.. 3 G3SE001E. 20/10/2004 0258  77390000-774D0000
CAWindaws\ SysWOWEH KemelB..,  N/A NiA Cannat find or .., 4 6396006 16/0420170%16  TSTCOO00-TBSTON0
Ef\orh c\threadLockChecker\Rele..  N/A Nk Cannat find or .. 502001 803272150 GOIADIOO-6416000 [T672]¢
Ef\omic\threadLockChecker\Rele..  N/A /A Cannat find or o... 6 001 2E/03/HNT 255 10000000-10010000  [7672]
CAWmdows\ SysWOWemfc100..  MWA /A Symbols loaded ... C\Users\stephen®AppDat... 7 10004021, 11/06/2011 0428 T2080000- 7248F000
CAWIndows\ SysWOWEmswcril.,  N/A NiA Symbols loaded.  C:\Users\stepher AppDat.. B 10004021, 11/06/2011 0200 T3A50000-T3BOFD..
CAWindows\SysWOWEHuser32.dll - N/ N Symbols loaded .. CA\Usersstepher\AppDat.. § 6306006 09/11/20161825  T70E0000-77233000
CAWindows\SysWOWEH\gdia2dll  N/A N/A Symbols loaded .. CA\Users\stepheriAppDat.. 10 63060018 O7/04/2017 1456  T4DEDDOO-TAEEEDN)
CAWindows\SysWOWEHadvapid..  N/A A Symbols loaded .. C\UsersistephertAppDat.. 11 63960006, 047122015 1%57  73350000-753CC0..
CAWIndows\SysWOWEH\shellB2dll - N/A MiA Symbsols loaded .. CA\Usersistepher\AppDat.. 12 639600.17.. Z7/08/2016 1700  TSCADDO0-TEEFED.. [T6721¢
MiA KA i 12 £ N2 e 1 1EMNA WA T NGNE TEIDAN TEIATAAL  TETTIE T
>

In the example abowve, for threadLockChecker.exe, the load address is 0x00130000.

WinDbg

https://msdn.microsoft.com/en-gb/library/windows/hardware/ff551063(v=vs.85).aspx

e Start WinDbg

¢ From the File menu, choose Open Executable. Choose your executable.

e Type Im, then press return.

e All modules are listed. Find your module. The start address is the load address.
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F E\om\c\dbgHelpBrowser\Release\x 86\ dbgHelpBrowser.exe - WinDbg:10.0,19041.1 86 - O x
File Edit View Debug Window Help
| = | B ELSHD 0O | N EEEEERGEEE] 8] A
Command n
gip=770asaas e=p=0019fa20 ebp=0019fadc iopl=0 nv up 2i pl =r na pe nc ~
oc==0023 ===002b d==002b e==002b {==0053 g==002hb ef1=00000246
ntdll!LdrpDoDebuggerBreak+0z2b:

770asaal co int 3

0.000: 1m

start end nodule name

no1do0000 oolfbkoon =wlPelnfo (deferred)

no400000 00526000 dbgHelpBrowser (deferred)

10000000 1000f£000 svlSupport (deferred)

73400000 73569000 gdiplus {deferred)

73650000 736b9000 HSWCE100 {deferred)

737a0000 73824000 COMCTL3Z2 {deferred)

73830000 73836000 HSTHG32 {deferred)

73e=0000 7431£000 nfcl0dn (deferred)

74350000 7440f000 MSWCR100 {deferred)

74420000 74428000 WERSIOH {deferred)

7470000 747ca00n CEYETEASE (deferred)

74740000 747f0000 S=piCli {deferred)

747£0000 74365000 zechost (deferred)

74870000 74967000 oled? {deferred)

74a=0000 74b9bo00 REPCET4 {deferred)

7dba0nnn 74bafonon kernel appocore (deferred)

74Eb0O000 74=29000 ADVAPTIZ {deferred)

7440000 74c9£000 borvptPrimnitives (deferred)

74400000 74417000 windZu {deferred)

74420000 752ec000 windows storage {deferred)

752f0000 752f6000 PSAFT {deferred)

7540000 75524000 SHIWAPT {deferred)

75640000 75747000 ISER3Z2 {deferred)

75720000 758c0000 EERHEL 32 {deferred)

75440000 Ytelf000 neEvert {deferred)

75=90000 76409000 SHELLIZ2 {deferred)

7480000 Fe504000 shoore {deferred)

76510000 76531000 GOIT32 {deferred)

76540000 7e55b0O00 profapi {deferred)

76570000 7eechbonn gdid2full (deferred)

7eed000n Ferefoon ucrthbase {deferred)

7e7£0000 7e7{fdO00 THEDC {deferred)

76800000 76813000 crypt=Ep {deferred)

76920000 76%ac000 EVCD Win (deferred)

769=0000 FechSO00 conbase (deferred)

7ece0000 FecizOonn OLEAUTZZ {deferred)

7ed0Oonnn 7ed43000 powrprof {deferred)

76d50000 7ed8bO00 cf gngril {deferred)

76d90000 7efSe000 EERNELBASE (deferred)

Trooooan ¥Y¥19a000 ntdll (pdb =vmbols) C:~ProgramData~dbg-~symn~wntdl
7b330000 7b451000 dbghelp {deferred)

Fhafonln 7ba?a0on =vlEditToolAfx (deferred)

]
< >
m:DDD>||

LnQ, Col0  Sys(<Local> Proc000:1bf0 Thrd 000:18dc  ASM  OVRE  CAPS  NUM

In the example above, for threadLockChecker.exe, the load address is 0x00130000.

Final Comments

OK, you should now know how to find the load address of a DLL or an EXE (or any module type).
Remember that a load address obtained this way is only valid for symbol decoding if the executable
doesn't have ASLR applied to it.
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If your crash reporting code only grabs crash addresses and not DLL load addresses, you need to
update your code so that you grab DLL load addresses at the time of the crash. That way you know for
sure what the load addresses were and you won't have to guess the load addresses in future.
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10

Command Line Interface

MapFileBrowser can be used from the command line as well as with the GUI.

The command line options allow you to view debug information that is in a MAP file, and optionally
highlight a symbol at a specified offset.

[fileName
Specifies the module to load. This is typically a .exe or a .dll.

/fileName path-to-executable

Example: /fileName e:\om\c\test\release\test.exe
loffset

Specifies an offset inside the executable. MapFileBrowser will highlight the symbol that
occupies this location.

Typically this offset will be calculated from a crash location.

For example:

If a DLL is loaded at 0x00400000 and a crash happens at 0x00420192, the offset is
calculated by subtracting the DLL load address from the crash address.

That is: 0x00420192 - 0x00400000, which gives 0x00020192.
The offset is 0x00020192.
The offset must be specified in hexadecimal with a leading 0x.
/offset value

Example: /offset 0x00020192

Example Command Line

32 bit applications
MapFileBrowser.exe /fileName e:\test\release\test.map /offset 0x00020192

64 bit applications
MapFileBrowser x64.exe /fileName e:\test\release\test.map /offset 0x00020192
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